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F1 DATABASE  

1 ABOUT THE APPLICATION

1.1 Introduction

This application, an executable file called “F1Database.exe”, is a
record  of  the  1-2-3  results  for  each  Formula  One  World
Championship from the first race in 1950 to date. It contains details
of the drivers, constructors, engines, circuits and venues for each
race. 

The  data  in  the  application  is  searchable  using  user-selected
filters.

This  manual  is  to  be  read  in  conjunction  with  the  application
“F1Database”.

1.2 System Requirements

The  minimum  system  requirements  for  this  application  are  not
known,  and I  don’t  know how to  establish  them.  For  what  it  is
worth, the application was developed on a PC with the following
specification:

 Windows 7 Home Premium 64-Bit,  upgraded to Windows 10
Home, version 1607, build 14393.187. 

 Chillblast Radeon HD 5850 1024MB Graphics Card.
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 4GB PC3-12800 1600MHz DDR3 Memory.
 Asus P7P55D-E LX Motherboard with USB 3.0.
 Intel Core i7 875 Processor (2.93GHz) Overclocked to 3.8GHz .
 Asus Xonar DS 7.1 PCI Sound Card.

If  you use the software on a PC with a different  specification,  I
would be very interested to hear of any issues you might have had,
or indeed, if you don’t get any issues at all! There is a link on my
web-site software page (see the link in the section following) which
opens a feedback form for you to contact me.

I  will  be  honest  here  and  state  that  the  application  should  run
happily  under  most  Operating  Systems  and  hardware
specifications.

1.3 Application Version

I will only update this manual if something major is changed to the
way the application functions for the user, or if I have added more
features  or  something  along  those  lines.  Simple  improvements,
bug fixes and the like, are not likely to generate an update to the
manual. But you are advised to visit my website “Software” page
and view the current version number of the manual to see if I have
updated it, and from where you can download the latest version.

Graham Hague Software

The application itself will be updated for similar reasons. For the
application, the “build” or version is described by a construction in
the format: “Version 1.2.3”. The first number, “1” in the example, is
the “main” version. This will only change with major changes to the
coding which cause the application to run, or display, significantly
differently  to  the  previous  version.  If  this  main  version  number
should change, the following numbers are reset to unity, i.e. “1.2.3”
would reset to “2.1.1”. The second number, “2” in the example, is
used to record changes that may appear to the user, but which do
not significantly alter the way the application works.  Changes to
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the second number reset the third, so “1.2.3” would become “1.3.1”
for example. Finally, the third number, “3” in the example, is simply
used to record minor changes to the code which may improve the
function without seriously changing the way it behaves. Examples
of such changes would be speed improvements, for example.

Regularly visit my website Software page in order to view the latest
versions of the application and this manual. You can then choose
to download updated versions if you wish.

You can check the version of the software application you have in
the usual fashion by clicking the menu option “Help” and selecting
(by clicking it) the menu option “About” which appears in the drop
down list.

1.4 Copyright

The software was created by me, Graham Hague, and is offered
for  download as  free software.  The  copyright  of  the  application
“F1Database.exe” and this manual:  “F1Database.pdf” belongs to
me, and is not transferable.  You are permitted to freely download
the software and manual, and to share it with your friends. 

You are not permitted to “reverse engineer” the application code,
or to make any changes to it  whatsoever. If  you think it  can be
improved,  use  the  feed-back  form,  obtained  via  a  link  on  the
software  page,  to  inform me of  what  you  would  like,  and I  will
incorporate it if I can when I get the time. In a like fashion, you are
not permitted to edit this manual in any way. I spent a lot of time
compiling the application and intend to make no money from it, nor
should you, so you are not permitted to sell the application or the
manual in any way, either electronically or physically. 

When you download any software or document from my web-site,
you  are  automatically  agreeing  to  these  conditions,  and  those
included on the software page, which you are strongly urged to
read before doing so.
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1.5 Precautions

Many  people,  myself  included,  are  nervous  of  running  an
executable  file  (a  file  with  the  extension  “.exe”)  that  has  been
downloaded from what is called an “unknown site”. It may be that
when you attempt to download the file, your browser may block it
completely, or may save it with a different filename and extension.
Chrome performs the latter if you have set the “Privacy” option in
Chrome’s settings to “Protect you and your device from dangerous
sites”.  In  this  case,  you  can  simply  download  the  file  and  in
Explorer, re-name the file to “F1Database.exe”, so the protection
offered  in  this  case  is  not  very  rigorous.  Since  a  recent  major
Windows 10 upgrade, Chrome has stopped doing this. 

Having downloaded any file from the internet, you can always run
your virus checker over it before you run or open it. In Windows 10
Explorer,  you  can  right-mouse-click  on  the  file,  and  from  the
window  that  opens,  select  “Scan  with  Windows  Defender”,  as
shown in the screen grab above. Although I do recommend you
always perform this on something downloaded from the internet, I
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have no idea how good it may be at finding a virus embedded in
any particular file type.

The software has been thoroughly tested on my PC, and will not
be offered for download until it appears to run correctly and without
causing  my  PC  to  “lock  up”  or  “crash”.  However,  my  PC  is
Windows 10 OS (Operating System) so I cannot test it on other
systems. That said, it should be fairly stable. Nevertheless, you are
strongly urged to save any data in other programs or applications
that  are  running  before  you  launch  this  application.  That  way,
something untoward happening will not lose you data.  

1.6 Compiler

The software was compiled by me using Delphi v3 initially,  and
then using Delphi v6 which I have just (September 2016) installed
on my Windows 10 PC. I am an amateur programmer, so please
accept  that  it  probably  won't  have  the  polish  of  a  professional
application,  and you  are getting it  for  free!  I  will  never  post  an
application on my web-site that has ever caused my own PC to
crash. That does not mean it will never do so on anyone else's PC
and set up.  It  seems to work on Windows 7,  8 and 10 with no
issues.  I  would  suggest  that  you never run  an  application  with
unsaved work open in any other app. This is just common sense,
really.

Please notify me via my web-site if you do get a crash. Feel free to
contact  me  with  suggestions,  hates,  ideas  for  improvement,  or
anything else that takes your fancy. This link will take you to my
web-site  feedback  form,  which  you  can  use  to  contact  me.
Obviously,  tell  me which software you  are commenting on,  and
what you were doing if you got a crash. I'll get back to you as soon
as I can. 

Graham Hague Feedback
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2 INSTALLATION AND REMOVAL

2.1 Installing the Software

This  section is  rather  inaptly  named,  as  there  is  no installation
necessary  beyond  downloading  the  software  to  an  appropriate
location  on  your  PC.  The  file  contains  all  the  data  and  code
required to run. However, you are strongly urged to perform the
download  in  a  certain  way,  which  makes  the  removal,  or  un-
installation of the application, very easy.

Basically, I recommend creating a new folder in which to download
and  store  the  application  and  this  manual.  This  folder  can  be
created anywhere on your computer’s hard drive, external drive, or
even a USB memory stick, and within any existing folder structure
you have already created.

Once downloaded, the executable file can be launched by double-
clicking it  in Explorer.  If  you think you may want  to  run it  quite
frequently,  you  may  think  it  helpful  to  create  a  short-cut  to  it.
Simply  right-mouse-click  on  the  file  in  Explorer,  and  choose
“Create Shortcut” from the drop down list. You can then drag the
shortcut  where  you  want,  perhaps  to  your  desk-top.  The
application can then be run by double-clicking on the shortcut icon.
You may also want to single click twice (not too fast) and rename
the shortcut to something more meaningful.
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2.2 Files Created by the Application

When it  runs,  the application creates a number of files that  are
interesting  to  the  more  experienced  user  who  may  like  to
interrogate them. The files are named with the extensions “txt” as
pure text files, or “ini” as slightly more structured text files. In both
cases,  they  can  be  opened  by  right-mouse-clicking  on  them in
Explorer, and choosing Notepad as the application to open them.
My Windows 10 PC has Notepad available on it, you may have to
hunt to find it, but mine was in the folder “c:Windows/System32”.
You can download similar apps from Windows Store, but they must
be  “pure”  text  editors.  That  is,  editors  that  do  not  “insert”  any
formatting codes, for example, as does Word.

Whilst these are simple text files, I urge you not to play with them
or  change  them,  as  you  may  inadvertently  do  something  that
confuses the application when it next launches. If you must play,
then only edit them in Notepad, do not use Word for example. It
must be a “pure” text  editor.  And if  you  do modify a file  and it
suddenly causes the application to work strangely, or even not at
all, simply delete the subject file you edited, and the application will
then recreate it when it next runs.

2.3 Removing, or uninstalling the application

When you  get  fed  up  with  this  application,  you  may decide  to
uninstall  it.  This  is  where  the advice about  downloading  it  to  a
folder of its own comes into play, as all you have to do is delete the
folder.  And that’s it,  application uninstalled.  This method is only
suitable  if  the  executable  file  was  downloaded  to,  and  always
launched from, a folder dedicated to it and it only. If you put the
executable into a folder containing other stuff, then it is a matter of
identifying  files  the  application  creates  itself,  as  well  as  the
executable  and  this  manual,  and  deleting  them  yourself  using
Explorer. Much easier is to delete a folder and its contents!
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2.4 Changes to your Computer

I have written all my software so that it makes no changes to the
host computer whatsoever, except for those files it  creates itself
and which are always saved to the folder from which it is launched.

The  application  makes  no  changes  to  your
computer’s registry settings, nor creates any
itself.  Uninstalling  by  deleting  the  file  is
therefore the only removal action needed to
delete it from the computer.

If  you  followed  my advice  and  downloaded  the  application  and
manual files to a dedicated folder for them, and always ran the
application from there or by a shortcut originally created there, the
simplest way to remove it is to delete the folder and its contents.

2.5 Using the Application

The application  has been designed to  be  similar  to  most  other
applications. There is a “Menu Option” list at the top, with names
“File”,  “Search”  and  “Help”,  and  each  has  a  list  of  “Sub-Menu”
options which appear when you click the main option. Most, if not
all,  the  actions  associated  with  these  menu  options  are  also
available by either clicking tool buttons, or filter buttons.

All  the tool  buttons have a hint  about  their  use,  which appears
when you hover the mouse over them.

You are advised to read section 4 “Performing a Search” which
uses the filter buttons in the filter panel at the right-hand side of the
application window.

Under the “Help” menu option is a sub-option “About”. This gives
details about the current build status of the application. This also
appears in the window title bar.

You can change how the application appears, how it displays data,
the amount of data it displays, and so on using the Preferences
option (under the File menu option, or the tool button with a pair of
tools on it), as described in section 5.
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All  settings  made  during  a  session,  including  form  positions,
colours, search filters and so on, are saved when the application is
closed, and reloaded when it is next run.

The  main  executable  file  is  only  updated  at  the  end  of  each
season.  You  can  download  from my  web-site  an  “updater”  file
which  contains  relevant  race  data  for  a  current,  incomplete,
season, in order to obtain that data. I will  maintain this file after
every race of  a season. Section 6 describes the updater file  in
more detail.

You can print the search result output using the menu option File >
Print, or by clicking the tool button with the image of a printer on it.
Printing is described in detail in section 7.

12



F1 DATABASE  

3 ABOUT THE DATA

3.1 Introduction

The data in this database is the 1-2-3 result, i.e. the drivers on the
podium, of every race in the Formula One World Championship,
from the first such race in 1950 to today.

The details of  the race, venue, circuit,  drivers,  constructors and
engines  are  recorded  and  available  to  view.  Occasionally,  a
comment about the race has been included.

You can choose to list these races with filters that refine the search
results. You can list as follows:

 All the results (takes a few seconds)

 A particular season from 1950 to date

 Results for a particular driver, constructor, or engine, and for
a particular circuit or venue.

The application interrogates its data and compiles lists of race wins
and championship wins by driver, constructor and engine. There is
even a “Specials” which lists races of particular significance such
as longest and shortest distance, fastest and slowest speed, etc.

13



F1 DATABASE  

The data embedded in the application are complete seasons only.
An “update” file will be available for download from my site which
contains the additional race data for the current unfinished season.
This  update  file  will  never  be  more  than  6KB in  size,  and  will
download in just a couple of seconds. I will update it pretty soon
after each race. This is more convenient than downloading the full
application  file  of  1.6GB  (as  in  2016)  which  takes  15  to  20
seconds. At the end of the season, I  will  embed the update file
data into the application and reset its version number; this permits
you to download the revised file and dispense with the update file
until the next season starts.

3.2 Sources of the Data

The application is fairly large, most of which is the embedded data.
The data was compiled by me using as my source (for seasons
1950 to 1994) the publication “Grand Prix Data Book”, by David
Hayhoe  and  David  Holland,  ISBN  0  9525121  0  6.  I  am  much
indebted to their extensive research necessary in order to compile
the hand book. My copy is  falling apart  after  much use. I  don't
know if current copies are still being printed. AbeBooks at:

http://www.abebooks.co.uk/book-search/author/david-hayhoe-
david-holland/ 

seems to have a few copies for just a couple of pounds, but the
date  is  1996  and  I  don’t  think  a  later  version  is  available.  For
subsequent seasons, I recorded the data from watching the races
on  television  and  using  their  race  summary  at  the  end,  or  by
reference to the Wikipedia pages linked from:

https://en.wikipedia.org/wiki/List_of_Formula_One_seasons

The best thing on this page is to scroll down to the bottom and
click the season year link you are interested in, as it includes the
current year in the list.

I was tempted to record all race placings, but doing just the first
three took me a lot of effort, and I think I would be in another place
before I would finish that task. 
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4 PERFORMING A SEARCH

4.1 Introduction

When  you  first  launch  the  application,  after  the  usual  “Splash
Screen”  which  is  shown whilst  the data is  set  up,  it  displays  a
simple  synopsis  of  the database.  It  tells  you  what  seasons are
covered, and whether an update file was detected. Refer to section
6 about the update file.

You can stop the splash screen from appearing by a setting in the
preferences window, see section 5.

The main area contains the introduction screen shown below; at
the top are some tool buttons which provide you with quick ways of
performing actions, whilst on the right-hand side is a panel with the
controls which allow you to select your search filters, and perform
searches on them. You can review the opening introduction screen
anytime by clicking the button marked “Help” at the bottom of this
right-hand panel.
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4.2 Setting Driver Search Filters

Describing how to set a “Driver” filter, for example, really describes
the way to set any filter. So to start, let’s say we want to look at
driver “Lewis Hamilton”. The “Driver” filter section appears at the
top of the right-hand panel:

Note that in this case, the driver’s name appears as surname first.
This is to help you find a driver to search for. The current name
may or may not be highlighted. Click the small down arrow at the
right hand end of the name box, and a small drop down list will
appear with a few names in alphabetical order. If you now press
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the “h” key (case is not significant), the list now starts with those
drivers whose surname begins with “H”. If necessary, scroll down
the list until the driver name appears, then click on it.

You have set driver “Lewis Hamilton” as the search filter. The main
display will automatically display the race wins for that driver. This
is  the same as selecting the driver  by typing  in  his  name, and
clicking the button marked “Wins Only”, but you are better off using
the selection method, as then name spelling errors won’t occur.

The colour  of  your  display may be different  to  the screen grab
shown.  Colours  are  set  using  the  “Preferences”  screen,  as
described in section 5.

Now try  clicking  the  three  buttons  in  this  “Driver”  section.  The
button marked “Podiums” will list all the races for which the named
driver  was  on  the  podium,  i.e.  finished  in  first,  second or  third
places,  whilst  the  button  marked  “Career”  will  give  a  career
summary for the driver. “Wins Only” will again list the default result
of only those races which the named driver won.

  

The three buttons can also be actioned by clicking the appropriate
tool button shown above.
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Please note that the “Career” option only lists the first occurrence
of a podium place, and the constructors the driver drove for when
he achieved a  podium finish,  and  not  the  first  time he actually
drove for a team. And if he never achieved a podium finish for a
team, the list of teams will not include it.

4.3 Setting Constructor and Engine Search Filters

The method of choosing a constructor or engine is similar to that
for the driver. Clicking the down arrow at the right hand end of the
name box displays a list which can be scrolled, or moved to by
pressing the first letter of the constructor or engine name, and the
desired  one  chosen  by  clicking  on  it.  The  simplest  way  to
understand it is to try it.

Constructors  and  engines  have  similar  buttons  to  the  driver,
marked  “Wins  Only”  and  “Podiums”,  which  perform  similar
functions for  the constructor  or  engine.  But  they also have two
additional  buttons  instead  of  the  “Career”  button.  The  button
marked “1-2 Places” will list those races where the constructor or
engine finished in the first two places, and the button marked “1-2-
3 Places” where they finished in all  three places. You won’t  get
many  recent  results  for  the  latter,  since  the  times  when
constructors could enter more than two cars in a race have long
gone.
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4.4 Circuit and Venue Searches

These  filters  are  set  in  the  same  way  you  are  becoming
accustomed  to.  In  this  case,  selecting  a  name,  or  clicking  the
button marked “Results”, lists the races for that circuit or venue.

4.4 Season Searches

These filters are slightly different, but their function should be fairly
obvious.

   

The box shows a box in the top left corner that displays the last
season in the database for which results are available. Next to it
are two buttons that index this season year forwards (the up arrow
moves  later)  or  backwards  (the  down  arrow  moves  earlier).
Clicking either arrow displays the full season results for the season
year  that  appears  in  the  filter  box.  The  years  will  not  advance
beyond the latest season year in the database, nor earlier than the
first year (1950). The button marked “Results” performs the same
thing, by displaying all the results for the selected year.

The two additional buttons are really self-explanatory, but anyway,
here goes. Clicking the button marked “First – 1950” will  display
the race results  for  the first  season in  the database,  i.e.  1950.
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Clicking  the  button  marked  “Last  -2016”  will  display  the  race
results  for  the last  season in  the database.  As the database is
updated, this second button label will automatically reflect the last
year.

4.5 Championship Searches

The  final  section  of  controls  in  the  right-hand  panel  is  marked
“Championship” and contains four buttons.

The  button  marked  “All  Races”  will  list  all  the  races  in  the
database, from the first  one in 1950 to the last. As of the 2016
Singapore race, this is no less than 950 race results. This is a lot
of  data  manipulation,  and  depending  on  the  speed  of  your
computer, may take a while (but in the order of a few seconds, not
minutes!) to complete.

The  button  marked  “Specials”  lists  those  races  which  may  be
termed to be significant for the Formula One World Championship.
These  include:  longest,  fastest,  shortest,  slowest,  plus  a  few
others.  These  do  not  take  into  account  races  included  in  an
updater file.

The button marked “Race Win Tables” will  display three lists, or
tables. The left-hand list is the Driver’s Wins, with the driver with
the most at the top. Currently, this is Michael Schumacher with 91
wins, a record I think is unlikely to be matched. The list is ordered
by wins,  but where drivers have the same number of wins,  it  is
further ordered by second places, then thirds. The middle list is the
wins by constructors, and the right hand list is those by engines.

These lists include all the races in the database, including those
contained in any update file (see section 6).
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Although the update file  can give you race data for  the current
season, the championship data will only be available for completed
seasons.

In the latter case, though, the right-hand list is in fact, two lists, and
show  the  counts  of  championship  wins  for  both  drivers  and
constructors.

 

Note that the colours may be different when you first launch, and
can be changed using the Preferences option, described in section
5.
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5 SETTING PROGRAM AND SEARCH PREFERENCES

5.1 Introduction

You can access the screen on which you can make program and
search preferences by any one of three methods:

 Choosing the menu system options “File” > “Preferences”

 The keyboard shortcut “Ctrl-T”

 The tool buttons:

  

Note that which of these tool buttons that appears in the window is
due to a setting in  “Preferences”  (see section 5)  and the initial
launch defaults to the smaller image.

The screen which opens is displayed on the following page. The
various  options  are  checked  according  to  the  last  settings  you
made on this screen, so may be slightly different when you open
the window.
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Each section of the window is a group of options associated with
similar things, and each will be described in turn.

23



F1 DATABASE  

5.2 Header & Footer Data

This  section  refers  to  the
race  data  displayed
following a search request.
There  are  four  options.  If
checked,  the  relevant
option  will  be  active,  if
unchecked, it will not be.

5.2.1 Show Day of Week.

If checked, then the day of the week will be included in the race
result  header,  if  unchecked, it  won’t  be.  So far,  every race has
always been undertaken on a Sunday, so including this data may
be considered rather superfluous.

5.2.2 Show Venue

In case you don’t want the venue to be included in the result data,
this option provides the ability to include it (checked) or exclude it
(unchecked).

5.2.3 Show Circuit

As with the venue, this is for you to decide whether you want to
include it (checked) or not (unchecked).

5.2.4 Show Race Comment

This option will  either  display a race comment  (checked,  and if
there is one) or not (unchecked). 
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5.3 Drivers & Engines

This  section  gives  some
options for  the race result
display  for  the  three
podium positions.

5.3.1  Show Winning Driver(s)

If  checked,  which  presumably  will  be  the  usual  selection,  the
winning driver(s) will be displayed, if unchecked he (or they, and
maybe one day, she) won’t be. The plural is because some early
drives were shared by two or even three drivers.

5.3.2 Show Second Place Driver(s)

This option, when checked, will show the second placed driver(s),
or if unchecked, will not.

5.3.3 Show Third Place Driver(s)

This option, when checked, will show the third placed driver(s), or
if unchecked, will not.

5.3.4 Show Car Engines

This  option,  when  checked,  will  show  the  constructor  name
followed by the engine name (if different). If unchecked, only the
constructor name will be displayed.
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5.4 Race Distance

This  section  is  where  you
can choose how to display
the  race  distance  units.
The  four  choices  are  all
mutually  exclusive;
selecting one will  deselect
the others.

5.4.1 In Miles

If checked, the race distance will be displayed in miles.

5.4.2 In Kilometres

If checked, the race distance will be displayed in kilometres.

5.4.3 Both Miles and Kilometres

If checked, the race distance will be displayed in miles followed by
the distance in kilometres in square brackets.

5.4.4 Do not display Race Distance

If  checked,  the  race  distance  will  not  be  displayed  in  the  race
header.

5.5 Winning Race Speed

These  options  are  very
similar  to  those  provided
for the Race Distance, and
determine  how  the  race
speed is displayed.
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5.5.1 In Miles Per Hour

If checked, the race winning speed will be displayed in miles per
hour.

5.5.2 In Kilometres per Hour

If checked, the race winning speed will be displayed in kilometres
per hour.

5.5.3 Both MPH and KPH

If checked, the race winning speed will be displayed in miles per
hour  followed  by  the  winning  speed  in  kilometres  per  hour  in
square brackets.

5.5.4 Do not display Race Speed

If checked, the race winning speed will not be displayed in the race
line for the winning driver.

5.6 Colours [if check box checked in “Program” panel]
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This  box  allows  you  to
change  the  colours  used
by  the  application  when
you display result  data, or
tables  of  wins.  There  are
seven  buttons  you  can
select,  from  “Search
Results  Window”  to
“Engine  Championship
Window”.  Selecting  one
automatically  de-selects
any  other,  and  then  the
colour  for  that  selection
can be adjusted using the
red, green and blue sliders
at  the  bottom  of  the
section.  The  colour  is
displayed  in  the  small
panel  alongside  the
selection.

None  of  these  features  can  be  selected  unless  the  check  box
“Coloured Text” is checked in the next section.

5.7 Program

This section allows you to make some
changes to the way the program itself
behaves.

This section lets you choose whether to display the tool buttons
Large  (“Large  Tool  Buttons”  selected),  or  Small  (“Small  Tool
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Buttons” selected). Checking the box “Coloured Text” will  cause
the results to display in colour, and will make the colour adjustment
controls  in  the  previous  section active.  If  the  check box  “Show
Opening  Splash  Screen”  is  unchecked,  then  next  time  the
application launches, the splash screen will not be displayed. The
setting up of the data still has to be performed, so the application
will seem to pause for a while until that is complete. The final two
options are mutually exclusive, and determine the font used when
printing. This can also be changed when you invoke a print.

5.8 Saving the Changes

When you first open this screen, the button marked “Save & Close”
is inactive. You can “Cancel” the window using the button marked
“Cancel”. But if you make any changes to any of the selections and
options on this screen, the “Save & Close” button becomes active,
so  you  can  save  your  changes.  Once  you  save,  the  “Save  &
Close” button again becomes inactive.

If you try and “Cancel” with the “Save & Close” button active, even
if all you did was make a change and immediately change it back,
then you will get a warning that you have unsaved changes on this
screen. This is just  to prevent you from inadvertently cancelling
when you wanted to save the changes. The message is “Changes
have been made and not saved. Close Preferences anyway and
loose changes?” You then have two options: “yes” will  close the
screen  and  lose  your  changes,  “No”  will  abort  the  cancel
command, and you can then make more changes, or save them. 

All the changes you made on this screen are immediately activated
when you close it, and are stored so that next time you launch the
application, these amended options will be used.
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6 UPDATER FILE

6.1 Introduction

The application comes with  the data  for  all  completed seasons
embedded within it. Data for a partially completed season can be
obtained by downloading a file from my web-site “Software Page”:

www.grahamhague.com/softwaref1database.shtml

So during a season, and before it has been completed, regularly
visit the site to download the updater file. The link is “Updater File”
and attempts to download a file  called “update.txt”;  case is  not
significant.  When  the  application  is  launched  at  any  time,  if  it
“sees”  a  file  called  “update.txt”  in  the  same  folder  as  the
executable application was launched from, it will  assume the file
contains updating data, and will attempt to incorporate the data it
contains into the database.

Because this file is a text file, and the browsers are clever enough
to recognise it as such even when I gave it an arbitrary extension
such as “F1D”, some browsers (Chrome is one) actually open the
text in a browser window. I have not yet found a way to prevent
this. So you will need to right-mouse-click on the window, and from
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the drop down list that appears, select “Save As”. Now you can
navigate  to  your  F1  Database  folder,  and  save  the  text  file
“update.txt” to it. The next time you launch the application, it will
detect  the  file  and  use  the  data  in  it.  If  you  have  already
downloaded an earlier updater file, allow the new one to overwrite
it.

6.2 File Details

The application will expect the data to be in a very precise format,
and if you load the downloaded file into some word processor or
whatever  and then save it,  you  may well  screw it  up.  You can
upload it to Notepad if you want to have a look at it, but even then,
it’s best not to save it in case there are unintended changes. If you
want to mess with this file, I give a detailed breakdown of how the
data is constructed in section 6.3, but I would always recommend
making a copy of the file before you mess with it. That said, you
can always re-visit my site and download the file again.

The  updater  file  should  never  exceed  about  6KB  in  size,  and
should  download  on  a  reasonable  connection  in  just  a  few
seconds.

At the completion of every season, I will embed the update data
into the executable. Therefore, at the end of the season, visit the
web-page  and  download  the  new  version  of  the  executable
application,  over-writing  the  old  one.  Remember  to  delete  the
updater file “update.txt” from your folder at the same time, or it may
confuse  the  application  by  carrying  data  which  has  been
embedded.

6.3 Construction of Data

It is possible you may at some time in the future be no longer able
to download an updater file from my web-site.  In an attempt to
prevent this ruining the validity of the F1 Database application, you
can update it yourself. This is not as difficult as it might seem on
the surface. 
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The updater file is pure text, so do not modify it  using anything
other than a pure text editor such as Notepad.

The file is made up of three sections, but when updating only the
current season, only the first will contain any data.

This first section contains the race result data for each race in the
partially complete season as a single discreet line. Each of the 21
elements of data are separated by the “pipe” symbol : “|”, located
(on my keyboard) at the bottom left corner, a shifted backslash.
The 21 elements are:

1 Race  date  in  the  universal  format  yyyymmdd,  so  27 th

September,  2016 would  appear  as 20160927. Note the
month is “09” and not “9”.

2 Race Venue. This is the country in which the race took
place

3 Race Circuit.  This is the circuit  at which the event was
held.

4 Race distance in miles.
5 Winning Driver name, Christian name and surname.
6 2nd Shared winning driver, these days usually empty
7 3rd Shared winning driver, these days usually empty
8 Winning Constructor Name.
9 Winning Engine Name (even if like Mercedes or Ferrari, it

is the same, it must be present)
10 The  Race  winning  speed  is  calculated  by  entering  the

race time in hours, minutes and seconds.
11 Second  placed  Driver  name,  Christian  name  and

surname.
12 2nd Shared  second  placed  driver,  these  days  usually

empty
13 3rd Shared  second  placed  driver,  these  days  usually

empty
14 Second placed Constructor Name.
15 Second placed Engine Name (even if  like Mercedes or

Ferrari, it is the same, it must be present)
16 Third placed Driver name, Christian name and surname.
17 2nd Shared third placed driver, these days usually empty
18 3rd Shared third placed driver, these days usually empty
19 Third placed Constructor Name.
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20 Third  placed  Engine  Name  (even  if  like  Mercedes  or
Ferrari, it is the same, it must be present)

21 Comment (optional)

I  construct  the  update  file  by  using  an  Excel  spreadsheet  to
contain the race data lines, and a formula that takes that data and
constructs the data line that needs to go into the update file, with
the  proper  separators  and empty  fields.  In  this  way,  I  can use
copy-paste to transfer data from previous lines, very helpful with
circuits, venues, drivers, constructors and engines.

Except  for  the  last  element,  and  all  fields  containing  shared
winning, second placed and third placed drivers, the other fields
are mandatory, and are shown in red. Even an empty field such as
for the shared drivers must exist in the file, though it will be empty.
The units for the race distance MUST be miles in the data line, but
for ease of obtaining the data which is usually metric, they must be
entered  on  the  spreadsheet  as  kilometres.  The  spreadsheet
automatically  converts  the  distance  into  miles,  and  uses  the
distance  and  time  entered  (in  hours,  minutes  and  seconds)  to
calculate the winning speed in miles per hour.

Perhaps the easiest way to see the data line is to view the file in
Notepad. Or take a look at this line which was constructed by my
Excel  spreadsheet  from  data  for  the  last  race  (at  the  time  of
writing) at Singapore on 18th September, 2016:

18/09/2016|Singapore|Marina Bay|191.897|Nico 
Rosberg|||Mercedes|Mercedes|99.415|Daniel 
Ricciardo|||Red Bull Racing|TAG Heuer|Lewis 
Hamilton|||Mercedes|Mercedes|Nico Rosberg led for 
all the laps. Lewis Hamilton was never able to 
challenge for the lead, after a mistake in 
qualifying left him 3rd on the grid. He had to 
withstand a spirited challenge from Kimi Raikkonen 
for much of the race.

Things  to  note  are  the  format  of  the  date  (dd/mm/yyyy  in  the
update file, but entered in the spreadsheet as yyyymmdd), the fact
that  distance  is  in  miles  and  speed  in  miles  per  hour  though
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distance must be entered in the spreadsheet as kilometers, and
the “empty” fields after each driver’s name showing there were no
shared  drives.  If  Nico  Rosberg  had  shared  the  drive  with  “Joe
Bloggs”, for example, the data line would have started:

18/09/2016|Singapore|Marina Bay|191.897|Nico 
Rosberg|Joe Bloggs||Mercedes|Mercedes|…

With only one empty field after the winning drivers’ names.

The  updater  file  is  only  intended  to  carry  race  data  for  the
incomplete season, however in case it is needed to extend over to
more seasons, there are the other two sections already mentioned.
These  sections  contain  data  for  completed  seasons,  and  are
normally empty. The race data section is terminated by a specific
separator, a line of three asterisks: “***”. The driver championship
data follows this separator, and is ended by another separator, a
line of three plus signs: “+++”. The Constructor championship data
follows that separator. Both driver and constructor championship
data lines are constructed in a different way, and are included in
the Excel spreadsheet on additional pages.

The driver championship update lines are constructed as follows:

1 Season Year
2 Number of Races in Season
3 Winning Driver’s Name
4 Constructor-Engine Name 
5 Number of Races Won by Driver
6 Number of Points obtained by Driver

All  are in red because all  fields are mandatory.  Each of the six
elements is  separated by that  pipe symbol,  and a  data  line  for
2015 season would have been:

The constructor championship lines are very similar:

1 Season Year
2 Number of Races in Season
3 Constructor-Engine Name 
4 Number of Races Won by Constructor
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5 Number of Points obtained by Constructor

Again, all are in red because all fields are mandatory. Each of the
five elements is separated by that pipe symbol, and a data line for
2015 season would have been:

2015|19|Mercedes-Mercedes|16|703

A note about the “Constructor-Engine” name in both cases. These
are not obtained by a drop-down box for constructor and one for
engine. You construct the name yourself. I cannot remember why I
did it this way, and may change it later.

All the previous race results for 2015 season
ending with…

29/11/2015|Abu Dhabi|Yas Marina|189.74|Nico 
Rosberg|||Mercedes|Mercedes|115.57|Lewis 
Hamilton|||Mercedes|Mercedes|Kimi Raikkonen|||
Ferrari|Ferrari|
***
2015|19|Lewis Hamilton|Mercedes-Mercedes|10|381
+++
2015|19|Mercedes-Mercedes|16|703

If you can no longer download the updater from my site and have
decided to maintain it yourself, note that the race data area, and
the other two areas, can contain data for more than one season.
So when a season has completed and you have added the last
race data to the first section, add the driver championship data to
the second section, and the constructor championship data to the
third section. Within each section, the order must be calendar, so
the first race of the next season must always start after the last
race of the previous, and the championship data lines must always
be consecutive.

These latter two sections would have appeared in a maintained 
update file that was including season 2015, for example, as shown
above. The box shows a completed maintained file for a single 
season (2015), with the championship sections in this case 

35



F1 DATABASE  

populated. The maintained file including completed seasons 2015 
and 2016 might (and I mean, might) be as follows:

All the previous race results for 2015 and 2016
seasons ending with…

18/09/2016|Singapore|Marina Bay|191.897|Nico 
Rosberg|||Mercedes|Mercedes|99.415|Daniel 
Ricciardo|||Red Bull Racing|TAG Heuer|Lewis 
Hamilton|||Mercedes|Mercedes|Nico Rosberg led for
all the laps. Lewis Hamilton was never able to 
challenge for the lead, after a mistake in 
qualifying left him 3rd on the grid. He had to 
withstand a spirited challenge from Kimi 
Raikkonen for much of the race.
***
2015|19|Lewis Hamilton|Mercedes-Mercedes|10|381
2016|21|Nico Rosberg|Mercedes-Mercedes|10|410
+++
2015|19|Mercedes-Mercedes|16|703
2016|21|Mercedes-Mercedes|17|734

Note  how  the  race,  driver  championship  and  constructor
championship data are kept in the separate sections, separated by
the separators. In each section, the data must be in chronological
order.  There  must  be  no  empty  lines  anywhere  in  the  file;  be
especially careful about a line at the end of the data, the last line
MUST be a data line, not the cursor on the next empty line.

6.4 The Excel Spreadsheet.

I constructed the spreadsheet to do two things. From the entered
data, it  constructed the data line in the precise format I need to
paste it  into the relevant procedure of my RAD project file. You
need not be interested in that. The second thing was to create the
line that was to be pasted into my update file, which is what you
will want to know about. I have therefore altered the spreadsheet
so it only does the latter, as a special file for you to download once
and then use, whilst I could keep the original for my own use.

You can download the Excel spreadsheet from my web-page. The
file is named “F1Update.xlsx”. I think it unlikely I will update it very
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often, but a version number will  be shown in the download link,
and in the file itself.

When entering the race data, copy and paste from previous entries
wherever  possible.  Note  that  you  enter  the race time in  hours,
minutes and seconds, the formula in column H must be copied
from the row above to calculate the Race Speed. The distance
entered  in  column  D  must  be  in  kilometres.  The  spreadsheet
automatically converts the distance and speed to miles and miles
per hour. You must also copy the formulae in columns T, U and V
from the previous row for each new one.

The compiled data line appears in column X, coloured red to help
you identify  it.  You  will  need to copy the formula  from the row
above to make it work for the new data line you have entered.

Entering new data for the Driver and Constructor Championship
sections is done on the second and third pages of the spreadsheet
respectively.  Apart  from  that  required  to  compile  the  data  line,
there are no formulae on these sheets. When complete, just copy
down the compiled data line from the previous row, to display the
new data line to be included in the relevant section of the updater
file.
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7 PRINTING

7.1 Introduction

Printing  the  results  of  a  search  or  other  interrogation  of  the
database is pretty simple. It can be invoked in one of three ways:

 Selecting the menu option under “File” > “Print”

 The keyboard shortcut “Ctrl-P”

 The tool buttons:

  

Note that which of these tool buttons that appears in the window is
due to a setting in  “Preferences”  (see section 5)  and the initial
launch defaults to the smaller image.

The Print window that opens allows you to cancel the request by
clicking the “Close” button. You can also select two options.
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7.2 Page Orientation

The  two  controls  on  the  left  of  the  section  marked  “Page
Orientation  &  Font”  allows  you  to  select  either  portrait  or
landscape. You should be able to guess how each one looks. But
if you are printing the result of a search, you are recommended to
use “Landscape”, as the data to print is less likely to scroll around
the print lines.

7.3 Font

There are two fonts offered, which should be available on any PC.
Courier is fixed at 10 pt size, and this means the character spacing
is fixed. So sections of a line appear under the same sections of a
previous line.  Ariel,  also at  10 pt,  is  a proportional  font,  so the
character  spacing  is  not  equal,  and  this  can  cause  different
sections of a line to shift from where they appeared in a previous
line. The best thing to do is try both, and then stick with what you
like.
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7.4 Large Output

On occasion,  and as shown in the screen grab above,  a small
window opens with  the print  screen,  with  a message about  the
number of  lines you intend to print.  This is simply a warning in
case  you  have  inadvertently  sent  a  large  print  request  to  the
printer,  and  allows  you  to  reconsider  before  proceeding.  The
warning doesn’t appear if the number of lines to print is less than
200.

7.5 Print Button

Clicking this  button prints  the data.  If  you  invoked Print  from a
search result window, the search result is printed. If you invoked it
from  the  Tables  window,  or  a  Help  window,  then  that  data  is
printed. 

7.6 Cancel Print

Although this option is provided, it is of little practical use. Printers
these days have large memories, and large amounts of data can
be sent to them very quickly, so trying to interrupt a print is usually
impossible.  That said,  I  shall  experiment  with  ways  of  halting a
print  even  under  these  circumstances,  and  if  successful,  will
embody it on a future revision.
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8 HELP AND THE ABOUT WINDOW

8.1 Help

There is some limited help available from within the application. It
does not take the form of current “Compiled Help” screens, but I
am working on compiling such a help method for the application. If
I can get it to work, I will include the file as an additional download,
and make links to the appropriate sections of  it  from within the
application, in the normal, current manner.

The Help that is presently embedded in the application is simply a
small window that opens with some help on it. Help screens stay
open whilst  you  perform actions on the screen you  were using
when you invoked the Help, and close when you close that screen.

The contents of a help window can be printed. 

8.2 About

The “About” window, accessed by clicking the “Help” main menu
option, and then choosing the “About” menu option, will display the
About screen. This contains the version number of the software,
and a short history of its development.
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This window is the best one to use to check the version of the
application you are using. The version is also displayed in the top
header of the main form.

Close this About screen by clicking the small close gadget (X) in
the top, right-hand corner of the title bar. 

If you click on the image of the McLaren, you will open my web-site
software page.

The image is a photograph I  took of a model I  own.  There are
some great Formula One pictures on the internet; I got hold of a
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fabulous one of Lewis Hamilton crossing the line in his Mercedes
with  the  chequered  flag  waving,  but  haven’t  been  able  to  get
permission to use it yet. Since I am giving the software away, I can
hardly pay a fee for permission of use for an image.
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